
A-61056   March 2003 1-1

1 Introduction

About this guide The Kodak Imagelink Archive Writer Interface Software application 
provides a high-level interface to the Kodak Digital Science Document 
Archive Writer 4800 and the Kodak i9600 Series Writers. It also 
provides a set of restricted functions for administrative tasks involved in 
using the software.

Throughout this manual, the term Writer is used to describe both the 
Kodak Digital Science  Document Archive Writer 4800 and the Kodak  
i9600 Series Writer. Any differences between the two Writers will be 
noted. This guide contains information and procedures necessary for 
setting up and running the Kodak Imagelink Archive Writer Interface 
Software (AWIS).

Organization In addition to this chapter, the AWIS User’s Guide is organized as 
follows:

Chapter 2, Installing AWIS: Provides hardware and software system 
requirements, instructions for installing an upgraded version of AWIS 
and how to start and exit AWIS . 

Chapter 3, AWIS Administration: Describes each screen in AWIS 
Administration, including explanations of each field as well as 
procedures on how to set up applications, Writers and film templates.

Chapter 4, AWIS Application: Describes each screen in AWIS 
Application, including explanations of each field as well as procedures 
on how to run a job.

Chapter 5, Troubleshooting: Describes problems you may encounter 
while using AWIS and provides a list of error codes.

Appendix A, Input Modes : Provides detailed information and examples 
regarding List files and Batch mode as well as information on how to 
create a List file. 

Appendix B, TIFFCHKR Functions: Provides information about the 
TIFFCHKR function and how to use it.

Appendix C, Glossary: Provides a listing of terms associated with the 
Writer and AWIS.

Appendix D, Index Formats, Image Addressing and Image Marks

Appendix E, Image File Specifications: details the specifications of the 
digital image files to be written to film.
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What is AWIS? AWIS is a Microsoft Windows application that provides a fully functional 
interface to the Kodak Digital Science  Document Archive Writer 4800 
and the Kodak  i9600 Series Writer. It is intended for those customers 
who do not want to develop their own application and whose needs do 
not require that the functionality provided by the application be 
completely integrated into their own existing software systems.

AWIS includes the following components:

 AWIS Administration  – allows access to all administrative 
functions. See Chapter 3 - AWIS Administration, for more information.

• Creates and maintains applications and film templates that define the 
film output (i.e., simplex, duplex, image marks, etc.).

• Defines the available Writers.
• Configures Poll mode.
• Configures performance parameters. 
• Purges jobs.
• Generates reports.

 AWIS Application – writes images using an application created 
via AWIS Administration. See Chapter 4 - AWIS Application, for more 
information.

• Controls and facilitates the transfer of image files from the imaging or 
scanning system to the Writer.

• Provides a status of Writer operations.
• Provides job status (i.e., Completed, Verified, Waiting for input, etc.) 

and verification.
• Generates the Transfer file that links the file name to the roll ID and 

image address, which are used to index the images for future 
retrievals.

• Generates reports.

 TIFFCHKR Software – checks the image files before being 
written to film to assure the images are compliant with what the Writer 
and application definition expects. See Appendix B – TIFFCHKR 
Functions,  for more information.

• Checks if required TIFF tags are present and have acceptable 
values.

• Checks if text files meet size restrictions or if they will be truncated.
• Validates compression format.
• Checks if the images meet scaling requirements and will fit across 

the width of the film.
• Checks if the images are located where indicated in the List file or 

Batch directory.
• Converts multi-strip images to single-strip images.
• Validates TIFF file size with the memory available on the Writer.
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 Awis.log – provides easy access to the Log file. See Chapter 3, 
“Error Logging tab” for more information.

What you need to 
know

Users of AWIS must understand the Microsoft Windows operating 
systems, including basic Windows terms and functions, and the basics 
of microfilm technology, especially image addressing. 

For Windows, you must understand the following concepts; if you are 
not familiar with these terms, it is recommended you use the manuals 
accompanying your Windows  software.

Button Icon

Click Mouse

Close Program Manager

Dialog box Pull-down menu

Double-click Shift+click

Drop-down list Single-click

Getting technical 
support

Read this section before contacting Kodak for technical support.

The following information is needed when contacting Kodak technical 
support for the AWIS Software. This procedure is current as of the date 
of this guide, but it may change without notice as conditions require.

Response Center assistance is available as part of the Service Agree-
ment. Refer to the Service Agreement Terms and Conditions for hours 
of availability.

Only a training System Administrator should place the call to the Kodak 
Response Center. The following items will be requested:

• A K-number that identified the AWIS Software.
• A brief description of the question or problem.
• A contact name and a phone number where the contact/customer 

can be reached.
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Phone numbers:

U.S. and Canada: 1-800-822-1414
International: 1-585-724-4675

The contact’s name and phone number will be taken by a Response 
Center operator. A Response Center System Support Engineer will 
return the call.

The goal is to answer inquires on the first call. However, depending on 
the complexity of the question, it may be necessary to confer with other 
technical resources. Therefore, the inquiry may require follow-up con-
tact.

Before calling the Response Center:

• Make sure that you have checked your input TIFF files with the 
TIFFCHKR application with the Multi-strip to Single-strip option 
enabled.

• Make sure you have changed the battery in your film cassette.
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2 Installing AWIS

System requirements The following minimum hardware and software requirements are 
required to run AWIS.

Hardware • 300 MHz Pentium II processor
• 64 MB RAM (128 MB recommended)
• At least 20 Gigabytes (GB) hard drive or enough space to hold the 

desired number of image files. It is recommended that the hard drive 
is at least 2 ½ times the size of the largest job you are running.

• CD ROM drive
• Monitor, keyboard, mouse
• Ethernet adapter compatible with IEEE 802.3 Ethernet. 3Com 

EtherLink III has been tested and is recommended for interfacing with 
the Writer 

• Cabling from PC to Writer

Software Microsoft Windows NT, v4.0 Client and Server version with Service 
Pack 4, Windows 2000 Client and Server.

Upgrading AWIS Installing a new system requires other setup procedures, which are not 
documented below. Professional services are available for installing a 
new system. Contact your local Kodak Field Engineer for information 
regarding the Kodak Imagelink Digital Document Archive System Pre-
Installation Accreditation.

If you want to upgrade AWIS from Versions 1.3 or greater, you can use 
the following Windows procedure:

1. Place the AWIS CD in the CD drive.

2. From the Start menu, select Start > Run .

3. Type x:\setup where x is the letter of your CD drive.

4. Click OK.

5. Follow the instructions on the screen.

When the upgrade process is complete, icons for AWIS Administration, 
AWIS Application, TIFFCHKR and AWIS.log will appear on the 
desktop. as well as be displayed under the Programs menu.

NOTE: The Writer must be rebooted to activate any firmware changes 
associated with this release.
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Starting the software To start AWIS:

1. In the Windows Start menu, select Programs>AWIS. The AWIS 
menu contains the Archive Writer Interface Software (AWIS), AWIS 
Administration, AWIS.log and TIFFCHKR.

2. Select the AWIS module you want to work with, AWIS 
Administration, AWIS Application, TIFFCHKR or AWIS.log. 

Refer to the following chapters for more information:

• Chapter 3, AWIS Administration
• Chapter 4, AWIS Application
• Appendix B, TIFFCHKR Functions
• Chapter 3, “File menu – Error logging tab”, AWIS.log

Exiting the software From the File menu, select Exit.
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3 AWIS Administration

This chapter provides an overview of the windows you have access to 
when using AWIS Administration, as well as procedures for setting up 
applications, film templates, defining a Writer, removing jobs from the 
system and printing a report. 

See Chapter 4, AWIS Application for an overview of the windows in 
AWIS Application and procedures for running jobs.

• From the Start menu, select Programs > AWIS Administration or 
click on the AWIS Administration icon.

The AWIS Administration window is displayed. 

The menu bar provides the following options:

File — allows you to set up applications, define Writers and film 
templates, provides access to the Advanced and Polling tabs and exit 
AWIS Administration.

Purge  — allows you to delete a job and its associated files from the 
system.

Reports  — allows you to print a report of current AWIS jobs.

Help — provides access to AWIS Administration help.
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File Menu The File menu contains the following options: Applications, Archive 
Writers, Film Templates, Options and Exit. 

File menu —
Applications

When you select Applications from the File menu, the AWIS 
Application Setup window is displayed. This window contains the 
following tabs: General, Begin Roll, End Roll, Transfer File, Error 
Logging, and Input Mode. Each tab allows you to set up an aspect of 
the application.

AWIS Application 
Setup 

The buttons on the bottom of the AWIS Application Setup window apply 
to all of the tabs.  If a button is grayed-out, it is not applicable for the 
active tab.

OK: saves the values on the tabs and closes the window.

Save: saves the values on the tabs, but does not close the window.

Delete: when the General tab is active, the selected application can be 
deleted. System-supplied default applications cannot be deleted.

Create : when the General tab is active, the Create New Application 
dialog box is displayed. 

Cancel: closes the window without saving any changes.

Procedures on how to create new applications can be found in this 
chapter.
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Application Setup — 
General tab

From the General tab, you can create or delete applications.

Application Name — select the name of an existing application from 
the drop-down list or you can create a new application by selecting 
Create . For procedures on creating a new application, see the section 
entitled, “Setting up an application” later in this chapter. 

Film Template Name — enter the name of an existing film template 
(up to 24 characters) or use the … button to select from a list of existing 
film templates or create a new film template. For procedures on 
creating a new film template, see the section entitled, “Defining a film 
template” later in this chapter.

Starting Image Address for New Roll  — enter the first image address 
for a new roll of film. This value must conform to the image addressing 
values defined in the film template. For more information see the 
section entitled, “Film Templates - Image Addressing tab” later in this 
chapter.
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Application Setup — 
Begin Roll and End Roll 
tabs

The Begin Roll and End Roll tabs allow you to configure header and 
trailer page information. Header and trailer pages are images that can 
be added to the beginning and end of a roll of film to provide 
information such as the name of the job, responsible operator, date, 
resolution targets and error or job logs.

Header and trailer pages are not assigned an image address, and the 
frame containing them does not receive an image mark. 

Each header and trailer page input file must be either a TIFF image file, 
or a text file, that conforms to the Writer’s input file specifications. For 
more information, see Appendix E, Image File Specifications . AWIS 
converts any text files to TIFF format prior to writing to film. Header 
page files should be kept in a different directory than trailer page files. If 
a directory contains multiple files, the files within the directory are 
sorted and written to film using the Windows file sorting algorithm, so be 
sure to name the files accordingly in order to get the desired sequence 
on film.

Begin Roll tab: 

Write Header Pages to film — if checked, the header pages found in 
the Header Pages directory are written to film at the beginning of each 
roll prior to the first image designated via batch or list input.

Header Pages Directory Path — enter the path to a directory name 
where the header images reside or select Browse  to display the 
Directory Selection window.

Browse — used to display the Directory Selection window. After you 
select a directory, the window disappears and the full path name of the 
directory is displayed in the Header Pages Directory Path text box.
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End Roll tab: 

Write Trailer Pages to film — if checked, the trailer pages found in the 
Trailer Pages Directory are written to film at the end of the roll after the 
last image designated via batch or list input.

Trailer Pages Directory Path — enter the path to a directory name 
where the trailer images reside or select Browse  to display the 
Directory Selection window. 

Browse — used to display the Directory Selection window. After you 
select a directory, the window disappears and the full pathname of the 
directory is displayed in the Trailer Pages Directory Path text box.
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Application Setup —
Transfer File tab

The Transfer File tab allows you to specify creation of Transfer files and 
configure the parameters associated with the Transfer files.

A Transfer file can be generated during the writing of images to film. It 
contains indexing information that can be uploaded to an image 
retrieval database. The location of each file is c:\Program 
Files\AWIS\Apps\(Application Name)\(Roll ID). The filename will be 
(Roll ID).xfr.

If a job spans more than one roll, the Transfer file for each subsequent 
roll will be created in the same directory as the Transfer file for the first 
roll. For example, when the transition from roll 1 to roll 2 occurs, the 
Transfer file <2.xfr> will be created in the directory <1>.

A standard or custom Transfer file can be generated. A standard 
Transfer file provides a cross-reference of input filename to Roll ID and 
image address. The page number within the input file is also listed. The 
fields are separated by tabs. See the 2-level example below, using 
page level reporting.

A custom Transfer file can be created via a user exit routine. This 
provides the capability to append additional data to the information in 
the standard Transfer file. For more information, see the KODAK 
Archive Writer Interface Software, Integrator’s Guide,  A-61057.
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Following are descriptions of the fields on the Transfer File tab:

Creation of Transfer File — a drop-down list box provides options for 
creating the Transfer file:

• None: a Transfer file will not be created.
• Standard: the system-defined standard Transfer file will be created.
• Custom: enables the fields User Exit, Transfer File Name, and Index 

Data File Name. 

- User Exit: the name of the user exit. This value is required when 
specifying a custom Transfer file.

- Transfer File Name: the path location of the custom Transfer file. 
If no value is specified, the file will be placed in the standard 
location.

- Index Data File Name: the path location of the index data file 
containing information to be appended to the standard data in the 
custom Transfer file.

Reporting Level — depending on the index format, Transfer file entries 
can be done at the book, document or page level.

• Page-level: the Transfer file will contain index information for every 
image on the film. Applicable to any index format.

• Document-level: the Transfer file will contain index information for 
every image located in a 3-level and 2-level frame on the film. 
Applicable to 3-level and 2-level index format.

• Book-level: the Transfer file will contain index information for every 
image located in a 3-level frame on the film. Applicable to 3-level 
index format.
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Application Setup — 
Error Logging tab

The Error Logging tab allows you to select the level and number of 
errors you want to post to the Error Log. The Error Log file can be 
accessed by clicking on the AWIS.log icon.

Error Logging Level — provides a  drop-down list allowing you to 
select the level of errors you want to log.

• Diagnostic: logs all diagnostic messages, as well as informational, 
warning, and severe errors. 

• Informational: logs all informational, warning and severe errors.
• Warning: logs all warning and severe errors.
• Severe: logs only severe errors. These errors are serious and will 

halt the system.

Trim Threshold — an entry in this field is required. Enter an integer 
between 40,000 and 9,999,999 bytes. The oldest errors in the Error Log 
file will be deleted in order to keep the size of the file less than this 
value.
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Application Setup — 
Input Mode tab

AWIS reads image files from a disk drive (usually a drive that is shared 
on the network) and sends them to the Writer. Input modes allow you to 
sequence image files as desired on film. AWIS supports these input 
modes: List file, Batch and Poll.

Input Mode — provides a drop-down list of supported Input Modes: 

• List File: in this mode, the image files to be written to film must be 
listed in a file using full pathnames. Files are read and written to film 
in the same order as they appear in the List file. See Appendix A, 
Input Modes for more information.

• Batch: in this mode, image files are read from the directory specified 
in the Input Source Path field. See Appendix A, Input Modes for more 
information.

• Poll: in this mode, AWIS searches for a Poll file, which is created by 
some other means external to AWIS. See the section entitled, “File 
menu – Options” later in this chapter for more information.

Image Type — the image type of the input files must be specified as 
single- or multi-page TIFF. This value effects the layout of images on 
film, especially when the film mode is duplex. See Appendix A, Input 
Modes for more information.

• Single-page TIFF: file contains only one image. Images can be 
written to film separately using single-level index format, or grouped 
with other images and written using 2- or 3-level index format.

• Multi-page TIFF: file contains multiple images and each file can be 
considered a two-level group. Images can be written to film using 
single-level index format but the two-level grouping will be lost. Two-
level index format allows the two-level grouping to be retained. The 
first image (simplex mode) or first two images (duplex mode) of each 
file will be written as level 2, and subsequent images will be written 
as level 1. This provides the capability to index and retrieve the entire 
multi-page file as a group. Multiple files can be grouped using three-
level index format.
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Input Source Path — the location of a directory if you selected a Batch 
or Poll input mode, or the location of the List file if you selected the List 
file input mode. A full pathname must be entered.

Browse — used to display the File Selection window for List file input, 
or Directory Selection window for Batch or poll input. After you select a 
file name or directory name, the window disappears and the full path is 
displayed in the Input Source Path text box. For more information, see 
“File Selection window” and “Directory Selection window” in Chapter 4.

Setting up an application Applications are set up via AWIS Administration. 

1. Select the AWIS Administration icon or Start>Programs>AWIS 
Administration to start the AWIS Administration function.

2. Select File>Applications . The AWIS Application Setup window is 
displayed.

3. Select Create . The Create New Application dialog box is displayed.

4. Enter the desired application name. The name can be a maximum 
of 25 characters, and include any keyboard character except an ‘ 
(apostrophe) and | (the pipe character). 
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5. Select a Based on Template from the drop-down list of existing 
applications and click OK. All parameters from the selected 
application are copied to the new application.

6. Change any of the copied parameters or set new parameters as 
necessary on the other tabs. The fields on these tabs are described 
earlier in this chapter.

7. Click OK to save the application and close the Application Setup 
window or Save to save the application and keep the Application 
Setup window displayed.
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File menu — Archive 
Writers

When you select this option, the Archive Writer Setup window is 
displayed. This window contains a General and Version Numbers tab.

Writer setup — General 
tab

The General tab allows you to set up a new Writer or modify or delete 
an existing one.

Name — provides a drop-down list of Writers currently set up in the 
system. Select an existing Writer from the list or if you want to set up a 
new Writer, click Create to display the Create Archive Writer dialog 
box. See the section entitled, “Setting up a Writer” later in this chapter 
for procedures. 

The following fields will contain a value only when a valid value is 
specified in the name field.

Device Model — memory configuration of the Writer. Large or Small is 
displayed; this value cannot be changed.

IP Address — the static IP address of the Writer is displayed; this 
value cannot be changed.

Exposure — enter/select an exposure value from 5 to 50 to lighten or 
darken the images on film. The default value is 14.

Power Down Interval in minutes — defines how many minutes must 
pass without activity before the status display on the Writer goes into 
power-saving mode. Value Range 00, 10 to 999 minutes. The disable 
value is 0.

File Transfer Interval in seconds — enter/select the number of 
seconds (1 to 600 seconds) allowed for a file transfer between AWIS 
and the Writer (any command file, images file, response file, status file). 
This value should be large enough to ensure the file transfer does not 
hang and there is adequate time for the transfer. The default is 60 
seconds.
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Writer setup — Version 
Numbers tab

When the Name field on the General tab contains a value, the Version 
Numbers tab displays the current version information for the Controller, 
DCSM Version, WRIB version, Film Drive, and Operator Interface.  The 
information on this tab is for viewing purposes only and cannot be 
changed. 
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Setting up a Writer Writers are set up via AWIS Administration. To set up a Writer: 

1. Select the AWIS Administration icon or Start>Programs>AWIS 
Administration  to start the AWIS Administration function.

2. Select File>Archive Writers. The Archive Writer Setup window is 
displayed:

3. Click Create.  The Create Archive Writer dialog box is displayed:

4. Enter a Writer name. The name can be a maximum of 25 
characters, and include any keyboard character except an ‘ 
(apostrophe) and | (the pipe character).

5. Click OK. The Create Archive Writer dialog box is redisplayed 
prompting you for an IP address.

6. Enter the static IP address that was defined for the Writer during 
installation of the Writer, and click OK. If you are not sure of the 
correct value, see your System Administrator.

7. The Archive Writer Setup window is redisplayed with current values 
obtained from the Writer. If desired, select new Exposure, Power 
Down Interval, or Transfer File Interval values.

8. Click OK or Save.
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File menu — Film 
templates

When you select Film Templates from the File menu, the Film 
Template Server window is displayed with the following tabs: General, 
Film Physical Attributes, Image Addressing, Frame Annotation and 
IMC. Each tab allows you to set up an aspect of the film template.  

Use the Film Templates window to set up a film template for each kind 
of roll you create.

Film templates — 
General tab

Use the General tab to define a new film template or select and modify 
an existing film template. 

Film Template Database — displays the path  to the film template 
database. This field cannot be changed.

Template Name — select an existing template from the drop-down film 
template database list, or you can create a new film template by 
selecting Create . For procedures on creating a film template, see the 
section entitled, “Creating a film template” later in this chapter.

Cassette Usage — select the number of cassettes to be written. You 
can select Write One Original or Write Two Originals  to write two 
duplicates simultaneously.

Film Measurement Units — select the measurement system you want 
to use when advancing film, applying a leader, etc. Select either 
English (inches) or Metric (millimeters). The default is English.

NOTE: Interdocument gap will always be measured in millimeters, 
regardless of this value.
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Film Templates — Film 
Physical Attributes tab

The Film Physical Attributes tab allows you to enter parameters that 
determine image size, spacing and location on film. Image polarity is 
also specified.

Film Mode — two film modes are supported: Simplex and Duplex.

NOTE: With optical film capture devices, Duplex is associated with front 
and back, since the fronts and backs of sheets of paper are 
directly imaged to film. With the Writer, the concept of front and 
back is not applicable since the input is electronic files, which do 
not contain fronts and backs, but rather are identified as single-
page or multi-page.

For more information about film layout relative to film mode and input 
file type, see Appendix A, Input Modes.

Simplex – Each frame contains only one 
image.

Duplex – A frame can contain one or two 
images. Images are written alternately to 
the A and B channels. The number of 
images in any individual frame depends on 
the index format and image level. If the 
index format is single-level, each frame will 
contain two images. If the index format is 2-
level or 3-level, the B channel will be left 
blank in any frame where a higher-level 
image follows the A channel image.
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Film Leader Length — enter the desired length of the film leader (from 
36 to 120 inches/914 to 3048 millimeters). The appropriate value is 
determined by the requirements of the equipment that will be used for 
subsequent retrieval of images. The default is 36 inches/914 
millimeters.

Film Advance Length — enter the desired length of film to advance 
between jobs (from 1 to 99 inches/26 to 2515 millimeters). The default 
is 1 inch/26 millimeters. 

InterDocument Gap — enter a value between 0.6 mm and 5.0 mm to 
set the distance between images on film. The default is 0.7 mm. This 
value will always be measured in millimeters regardless of the Film 
Measurement Units.

Scaling and Reduction Ratio — The Writer can archive documents at 
1/20 (20X) to 1/99 (99X) of their hard copy size. Reductions are 
achieved through image file scaling. See the illustration entitled, 
“Examples of scaling and image orientation on film” at the end of this 
section.

Scaling — There are two choices: No Scaling or Automatic . 

• No Scaling: Image size on the film is dependent on the digital 
resolution (dpi) of the image file.
The maximum page widths and lengths accommodated by the Writer 
are listed below for No Scaling.

• Automatic: image size on the film is independent of the digital 
resolution (dpi) of the image file. Automatic scaling to a desired 
reduction is recommended for most applications. Reduction Ratio is 
enabled when scaling is Automatic.
Standard microfilm reductions are recommended:

- Simplex: 24X, 28X, 32X, 40X

- Duplex: 40X, 50X

Image 
Resolution 

dpi

Effective 
Reduction 

Ratio

Maximum 
Width 

Simplex

Maximum 
Width Duplex

Maximum 
Length

100 77X 38.5 in.
977 mm

19.0 in.
482 mm

68.5 in.
1740 mm

200 39X 19.3 in.
490 mm

9.5 in.
241 mm

34.3 in.
871 mm

300 26X 12.8 in.
325 mm

6.3 in.
160 mm

22.8 in.
579 mm

400 19X 9.7 in.
246 mm

4.8 in.
121 mm

17.2 in.
436 mm

600 13X 6.4 in.
162 mm

3.1 in.
78 mm

11.4 in.
289 mm
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The maximum page widths and lengths accommodated by the Writer 
are listed below for standard reductions.

Reduction Ratio — select a predefined option (24X, 40X, 50X) or 
Custom.  If you select Custom , the Scaling Factor option becomes 
enabled.

Scaling Factor — enter the scaling factor as a number from 0 to 99 
(i.e., 32 would be a 32X reduction ratio).

NOTE: Reducing more than 60X may produce undesirable image 
quality and is not recommended.

Image Polarity — The Writer has the ability to write images in a 
positive or negative image polarity. Positive is black characters on a 
clear background. Negative is clear characters on a black background. 

Retrieval considerations dictate polarity requirements. 

• Positive
- Retrieval equipment does not need the capability of inverting 

images for display.

- Lack of definitive borders may occur in some images on film. An 
image border can be placed around positive images during 
writing to film, to delineate the edges of the image.

• Negative
- The default in traditional microfilm retrieval equipment.

- Minimizes the impact of dust or other contamination when 
displaying an image during retrieval.

Standard 
Reduction Ratio

Maximum Width 
Simplex

Maximum Width 
Duplex

Maximum 
Length

24X 11.9 in.
302 mm

5.9 in.
149 mm

21.2 in.
538 mm

32X 15.9 in.
403 mm

7.8 in.
198 mm

28.3 in.
718 mm

40X 19.3 in.
490 mm

9.5 in.
241 mm

34.3 in.
871 mm

50X 24.9 in.
632 mm

12.3 in.
312 mm

44.3 in.
1125 mm
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Examples of scaling and image orientation on film

NOTE: If rotation is desired, the images must be rotated by a third-party 
software product prior to passing the images to AWIS.

Letter and legal size documents
 scanned as follows:

These scanned images will print to film as follows:

Legal
S
c
a
n
n
e
r

200 dpi

Letter

Legal Size
Image Width = 1700
Image Length = 2800

Letter Size
Image Width = 1700
Image Length = 2200

Original resulting values
in the TIFF header tags:

Film Writing

Scaled to 24:1 Simplex 

Figure 1

Same images from Figure 1

Letter Size

Image Width = 1700
Image Length = 2200

Legal Size

Image Width = 1700
Image Length = 2800

Original resulting values
in the TIFF header tags:

These scanned images will print to film as follows:

Film Writing

Scaled to 32:1 Simplex 

Images are rotated by a
software package

Letter Size
Image Width = 2200
Image Length = 1700

Legal Size

Image Width = 2800
Image Length = 1700

Resulting values in the
TIFF header tags

after rotating:

Figure 2
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Film Templates — Image 
Addressing tab

The Image Addressing tab contains parameters for controlling how 
image addresses are created, and at what level each image will be 
written to film. These values determine what will be accepted as a valid 
starting image address for a new roll, in application setup.

See Appendix D, Index Format, Image Addresses and Image Marks for 
detailed information.

Index Formats — a drop-down list of formats that can be used for the 
images: No Indexing, Single Level, Two Level, and Three Level . This 
value effects the hierarchal grouping of images on the film.

Field Width — the maximum number of characters needed in that 
segment to accommodate the largest value that will be assigned during 
the writing of images to film. For example, on a single-level roll with 
10,000 images, the Level 1 field width must be at least 5. The total for 
all enabled segments cannot exceed 12 but the maximum for each 
individual segment is 9.

NOTE: Level 0 images are not assigned an image address.

An image address can have up to four segments depending on the 
Index Format selected. 

A field width must be specified for each enabled segment, except Fixed 
which is optional. If you select Single Level index format, Level 1 field 
width is enabled. If you select Two Level index format, Level 1 and 
Level 2 are enabled. If you select Three Level index format, Level 1, 
Level 2 and Level 3 are enabled.

Level Rule — the default level rule may be changed but it is not 
recommended since they provide the most efficient and predictable 
results. For more information about image levels, see Appendix D, 
Index Formats, Image Addresses and Image Marks. 

Set default — returns level rules to the original recommended settings.
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Film Templates — Frame 
Annotation tab

The Frame Annotation tab contains parameters for optionally writing 
the image address and reduction ratio on the frame in human-readable 
characters placed between the image mark and the actual image.

Example 1:  Simplex, 24X reduction with frame annotation enabled.

Example 2:  Duplex; 24X reduction with frame annotation enabled.

Following are descriptions of the fields on the Frame Annotation tab:

Enable Frame Annotation  — allows you to write annotation 
information on film.

Frame Annotation Position — not supported in Release 3.1. 

Enable Image Border — when this option is enabled, a thin border will 
be placed around all images. Placing a border around images helps 
identify the boundaries on positive polarity images.

Frame Annotation Orientation — not supported in Release 3.1.
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Film Templates — IMC 
tab

The IMC tab controls the type of IMC (Image Management Code) that 
will be written to the film preceding the images for every job that uses a 
film template with IMC enabled. 

IMC capability includes lead-end and preset coding, which provide 
automatic setup parameters for the image retrieval device.

Enable IMC — provides a drop-down list that allows selection of IMC 
as implemented for various Kodak optical film capture devices. This 
facilitates integration of the Writer in environments where the retrieval 
devices support current Kodak IMC. The options are: Disable IMC, 
Enable IL70 code, Enable RIM2000 code, or Random Batch. The 
default is Disable IMC.

Image Marks — not supported in Release 3.1.

Image Mark Author — determines the alignment of the image mark 
relative to the image, and the physical dimensions of each image mark 
size. Select either Kodak  (default) or Other. Kodak image marks have 
the leading edge of the image mark aligned with the leading edge of the 
image. 

Search Program — if IMC is enabled, a search program must be 
specified. The search program tells the retrieval device which film 
channel(s) (A and/or B) contain image marks, the image mark sizes 
present on the film, and the image level represented by each image 
mark size. This allows the retrieval device to locate and count the 
image marks according to your needs. There are 31 search programs 
available for use when writing images to film but the Writer does not 
support creation of film for all of these. The drop-down box contains the 
search programs that are supported by the Writer.
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The table below provides information about the supported search 
programs, to assist you in determining which program is appropriate 
based upon the film to be written and the retrieval needs.

NOTE: The Search Program field drop-down box contains a value of 
“1”, but the table does not. Search program 1 is used for 
odometer-indexed film, which has special retrieval requirements 
and does not contain image marks.

Splice Definition — specifies how film splices will be counted during 
retrieval. The drop-down list provides these splice definitions: Ignore 
Splices (default), Count splices as Level 1, Count splices as Level 2, or 
Count splices as Level 3. 

Duplex Front Channel — cannot be changed. The Writer supports 
image mark creation in the A channel only.

Image Orientation — cannot be changed. For more information about 
image orientation, see “Examples of scaling and image orientation on 
film” earlier in this section.

Index Format Image Mark 
Location

Image Mark 
Sizes

How image marks will be counted 
during retrieval

Search 
Program

Single-level Channel A Small Count small image marks as level 1 
images.

3

2-level Channel A Small
Medium

Count small image marks as level 1 
images, and medium image marks as 
level 2 images.

10

3-level Channel A Small
Medium
Large

Count small image marks as level 1 
images, and both medium and large 
image marks as level 2 images.

12

3-level Channel A Small
Medium
Large

Count small image marks as level 1 
images, medium image marks as level 
2 images, and large image marks as 
level 3 images.

18

Any Channel A Any/All Count all image marks as level 1 
images.

7
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Creating a film template Film templates are created via AWIS Administration. To create a film 
template follow the procedures below.

1. Select the AWIS Administration icon or Start>Programs>AWIS 
Administration  to start the AWIS Administration function.

2. Select File>Film Templates. The “Default” template appears in the 
Template Name text box.

3. Click Create . The Create Template dialog box is displayed. 

4. Enter the name of a new template and select an existing film 
template that the new template will be based on and click OK. The 
Film Template Server window is redisplayed with the new template 
as the current template. All parameters from the “based on 
template” are copied to the new film template.

5. Change any of the parameter values on the tabs as necessary.

6. Click OK to save the template and close the window or Save to 
save the template and keep the window displayed.
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File menu — Options When you select Options from the File menu, the Options window is 
displayed. This window contains the Polling and Advanced tabs.

Options — Polling tab The Polling tab allows you to configure the parameters associated with 
Poll mode. In Poll mode, AWIS searches for a Poll file, which is created 
by some other means external to AWIS and placed in a polling directory 
that is specified during application setup. When the Writer is integrated 
with a scanner, Poll mode facilitates simultaneous scanning and filming 
of images, without the need of an intermediate, manual batching step. 
After all images indicated by a Poll file are processed, the Poll file is 
deleted from the polling directory, and polling resumes.

Following are descriptions of the fields on the Polling tab:

Poll Interval — enter the amount of time, in milliseconds, that the 
AWIS application will wait between searches for a Poll file to be 
processed. The default is 3000.

Poll File — enter the name of the file which AWIS will search for. If 
various files will be used, wild cards (Windows file system wildcards are 
acceptable) are allowed in this field. The default is *.dat; this will allow 
processing of any file, placed in the polling directory, that ends with a 
.dat extension.
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Pollfile — select the method by which the Poll file should be 
processed. 

• Check Contents for Path: a Poll file may be empty, or contain a full 
pathname to either an input List file or batch directory. If the Poll file is 
empty, the Poll file is processed the same as the Filename as Path-
Ignore Contents method, and must comply with the requirements of 
that method. If the Poll file contains a full pathname, the specified List 
file or batch directory is processed according to the application setup 
and film template parameters.

• Filename as Path - Ignore Contents: an empty Poll file can be used 
to specify an input batch directory. The Poll file name must be the 
same as the batch directory name, and the Poll file must be placed in 
the same home directory where the input batch directory is located.

• Contents is Listfile: a List file can be used as a Poll file. This 
provides a method for automatically submitting List files which will 
then be automatically processed. When processing is complete, the 
List file is removed from the polling directory and copied to the same 
directory as the Transfer file for the job.

Options — Advanced tab The parameters on the Advanced tab are set to optimize performance. 

During installation the values of these parameters are set to the default. 
For most applications, the defaults are sufficient and should only be 
changed to address a specific issue and after a thorough review of the 
following information.

Following is a description of the fields on the Advanced tab:

Number of Commands — The maximum number of print commands 
that can be active simultaneously. The maximum value depends on the 
Number of Files value since the product of the Number of Files and 
Number of Commands, cannot exceed 120. Default 8. 



A-61056   March 2003 3-27

Number of Files — The maximum number of image files that a print 
command can contain. The maximum value depends on the Number of 
Commands value. The product of the Number of Files and Number of 
Commands cannot exceed 120. Default 8.

The Number of Commands and Number of Files work together to 
maximize command and image throughput by minimizing the amount of 
time the Writer will have to wait for print commands. This is 
accomplished by ensuring that there are at least two commands active 
at once: the command currently being processed by the Writer, and the 
command on the Writer disk waiting to be processed. For AWIS, this 
results in four active commands:

• one command being built and copied to the Writer
• one response received from the Writer when a command is 

completed
• the two commands on the Writer (one waiting to be processed and 

one being processed)

This implies that the minimum value for Number of Commands is 4. 
This value is usually left at the default value of 8, which allows a few 
extra commands available if needed.

Image file size and Writer disk size must be considered when 
determining the appropriate value to enter for the Number of Files. To 
determine this value, use the following formula as a guideline:

For example:

File Retry Count — The number of times AWIS attempts to copy an 
image file to the Writer before giving up and signaling an error. This 
value is used in conjunction with the Retry Delay value to determine the 
total amount of time AWIS will wait for the Writer to process existing 
commands and image files and make space available on its disk. 
Default: 20.

Retry Delay  — The amount of time (in milliseconds) to wait before 
attempting to copy an image file to the Writer again. This value is used 
in conjunction with the File Retry Count value to determine the total 
amount of time AWIS will wait for the Writer to process existing 
commands and image files and make space available on its disk. 
Default: 2000.
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The combination of the default Retry Delay (2000 milliseconds) and 
default File Retry Count (20 attempts) gives the Writer 40 seconds to 
finish processing commands and image files and make space for new 
commands and files. For most applications this is sufficient; however, 
when processing very large image files (greater than 750K), 40 
seconds may not be enough. In this case, the File Retry Count needs to 
be increased. Increase the value in increments of 5 until the largest file 
can be processed without a 3034 error occurring. It is important not to 
set this to some arbitrarily large value, because in the event of an error, 
this can increase the time it takes to report the error. Setting File Retry 
Count to a value too small causes the 3034 error to occur more 
frequently.

Generally, the Retry Delay should be kept at the default. Decreasing 
this value causes the copy requests to become more frequent but also 
increases network traffic. Increasing this value may cause a loss of 
throughput.

The product of Retry Delay and File Retry Count must be a time interval 
larger than the time it takes to process the largest image file.

Transaction Timeout —The maximum time (in seconds) AWIS will 
wait for the Writer to process a command and send a response. 
Default: 180. This value may only need to be changed when the 
processing of a print command and its associated images takes longer 
than 90 seconds.

The value of this parameter should always be about 30 seconds larger 
than the time specified by the Retry Delay and File Retry Count 
parameters.

NOTE: If network performance seems to be an issue, the following 
values may optimize performance: 4, 4, 40, 2000, 300 
respectively.

File menu — Exit Select File>Exit to close AWIS Administration. 
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Purge menu When you select Purge from the menu bar, the Purge Job window is 
displayed. Use this window to remove any or all of the following from 
the system: job data, input List files, Transfer files, and image files.

NOTE: Only verified jobs and their associated files can be deleted using 
the Purge function. See Chapter 4 , “File Menu — Verify Jobs” 
for more information. 

Jobs — displays information about the jobs that have been verified, 
including the job name, the application used to run the job, the date and 
time that the job was started, the fact that the job was verified, the login 
ID of the operator who verified the job, the workstation ID of the host 
PC from which the job was run, the Roll ID assigned to the film when 
the job was run, and a status code of 4 (the code for “verified”). 

Rolls — displays information for the roll of film associated with the 
selected job, including the Roll ID assigned to the film when the job was 
run, the total number of images written to film using that job, the first 
and last image addresses assigned using that job, the date and time 
that the job was completed, and the roll number indicating whether the 
job required more than one roll of film.

NOTE: The columns and rows on the Purge Job window can be resized 
by positioning the mouse on the column or row lines in the 
headings and moving the mouse, while holding down the left 
mouse button, to the desired position.
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Purging jobs and /or 
associated files from the 
system

To remove job data and/or associated files from the system:

1. Select the AWIS Administration icon or Start>Programs>AWIS 
Administration  to start the AWIS Administration function.

2. Select Purge from the main menu. This will be available only if there 
are jobs with a status of Verified  in the system. 

3. Select the desired job from the Jobs table. 

NOTE: Even though multiple jobs can be selected at one time, the 
system will only perform actions on the first job selected.

4. Click Purge . The Purge Job [jobname] window is displayed.

5. Select one or more of the following options:

- Delete Job Records from AWIS Database: allows the Roll ID 
associated with the job to be re-used, if necessary, by the 
application used to run the job. All data pertaining to the selected 
job will be deleted from the awis.mdb database and the job will be 
removed from the Jobs table in the Purge Job window. If this 
option is used alone, the capability to use this purge function, to 
remove associated files for the job from the system, will be lost.

- Delete Input Source List File(s): this option is enabled only if a 
List file was used to submit images for the job, and the file was 
not previously deleted using this purge option. This option may be 
used alone to delete just the input List file and not remove the job 
from the Jobs table.

- Delete Index Data File: this option is enabled only if a customer 
Transfer file was generated using an index data file. This option 
may be used alone to delete just the index data file and not 
remove the job from the Jobs table.

- Delete Transfer File: this option is enabled only if a Transfer file 
was created. This option may be used alone to delete just the 
Transfer file and not remove the job from the Jobs table.
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- Target Directory Path: this option is enabled and a value must 
be specified only if the Delete Job Records option is selected and 
the Delete Transfer file option is enabled but not selected. This 
option provides the capability to move the Transfer file rather than 
delete it. This field must contain a valid path to a directory where 
the Transfer file will be moved. The ... button can be used to open 
the Directory Selection dialog box and navigate to the desired 
directory, or a path can be typed directly into the Target Directory 
Path field.

- Delete Input Source Image Files — this option can be used to 
delete the source image files when a List file was used to submit 
images for the job, and the List file is still on the system. The 
accompanying fields are informational only.
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Reports menu When you select Reports from the menu bar, the Print Reports window 
is displayed. Use this window to print and/or export a report of current 
AWIS jobs with a status of Complete or Verified. The report format 
cannot be changed but the report content can be customized. The 
report provides information regarding the jobs run and rolls of film 
written for each application defined via application setup. See the 
sample report at the end of this section.

From Application — determines whether the report includes 
information about all applications or only selected applications.

Include Jobs — determines whether the report will include all jobs for 
each specified application or only those that fall within a range of dates.
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Printing and exporting 
reports

To print and/or export a report:

1. Select Reports from the AWIS Administration main menu. The Print 
Reports window will be displayed.

2. From Application:  Select either All Applications  or Select… 
based upon what applications you want to include in the report. If 
you choose Select… , the Report Application Selection window is 
displayed.

3. Select an application from the Applications list, then click the > 
button to add the application to the Include in Report list. Repeat for 
all desired applications. If most applications are to be included, use 
the >> button to add all applications to the Include in Report list, 
then select and remove the unwanted applications with the < button.

4. Click OK. The Print Reports window is redisplayed.
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5. Include Jobs: Select either All or Range based upon the jobs you 
want included in the report for each selected application. If you 
select Range, the From Date and To Date fields are enabled and 
must be specified. A small calendar is displayed, which allows you 
to easily select the desired day, month and year.

6. Click OK in the Print Reports window. The Preview window is 
displayed:

.

NOTE: The format of the report cannot be changed.

Following are descriptions of the fields and buttons on the Reports 
Preview window:

# Images — displays the number of images written to film.

Elapsed Time  — the time it took to run the job.

Start/End — displays the dates that the job was started and completed.

First I/A and Last I/A  — assigned to the images written to film.

Operator and Machine ID  — who ran the job and the name of the 
Writer used to write images to film.

Date — displays the date that the report was printed/exported.
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Buttons

Help menu The Help menu contains three options:

This window  — opens the Help dialog box to display the on-line help 
page that applies to the currently active window.

Contents and Index — opens the Help dialog box to display the first 
page of the on-line help with Contents and Index tabs.

About  — displays a window containing software copyright and version 
information.

Goes to the first page. Zoom/reduce the screen 
display (toggle)

Goes to the previous page.
Opens the Print dialog box for 
the default printer for the PC 
you are working on. 
NOTE: The printer cannot be 
changed.

Goes to the next page.
Opens the Export dialog box. 
Destination can be “Disk file” or 
“Mail via MAPI”. Disk file is the 
default.

Goes to the last page.
Opens the Export dialog box. 
Destination can be “Disk file” or 
“Mail via MAPI”. Mail via MAPI 
is the default.

Cancels an action. Closes this window.




